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1. WHAT IS THIS MANUAL FOR? 

This manual provides step-by-step guidance on how to submit an application for 
verification via the Java Verified Submission Portal and gives an overview of the 
services provided by the Submission Portal once you have submitted an 
application. It takes you through all the steps involved in the verification process 
from obtaining a Publisher ID to the final online submission of your application for 
testing and signing. Please remember that all applications to be submitted must 
comply with the Java Verified test criteria. For full details of these test criteria and 
of supported devices, please visit our main website www.javaverified.com.  
 
 
2. WHAT IS THE JAVA VERIFIED SUBMISSION PORTAL? 

The Java Verified Submission Portal is the place to go for Java Verified technical 
services. The Submission Portal firstly takes you through a process that allows 
you to submit your application. Once your application has been submitted to the 
portal, it then allows you to access the following services: 
 
• R&D Signing – signing the application for testing purposes 
• Submitting the application for testing – getting applications tested and 

signed as “Java Verified” 
 
 
3. WHAT IS A PUBLISHER ID AND HOW DO I USE IT? 

3.1 What is a Publisher ID?  

The prerequisite for using Java Verified services is to have a Publisher ID. The 
Publisher ID is a certificate that proves the existence of the developer and the 
company the developer works for and is used to sign the applications that are 
submitted to Java Verified for R&D, signing and testing. In other words, the 
Publisher ID is your passport to using Java Verified services. The key things to 
note about the Publisher ID are: 
 
• It costs 200USD/year 
• It is valid for one year. When it expires it can no longer be used and must 

be renewed.  
• Signing with a Publisher ID carries no additional cost.  
• An application signed with a Publisher ID cannot be installed to a live device 

(unless installed to a MIDP 1 device where the signature has no effect).  
 
3.2 How do I obtain a Publisher ID?  

To obtain a Publisher ID, you will need to pay the required fee and pass a simple 
vetting process, which includes the submission of documentation proving the 
existence of the company and your right to submit applications on its behalf.  
 
To get a Publisher ID go here: 



4  

https://www.trustcenter.de/cs-bin/PublisherID.cgi/en/155102 
 
For more details about what you are spending your money on, go to: 
http://www.trustcenter.de/en/products/tc_publisher_id_for_symbian.htm 
 
Note: Java Verified uses the Publisher ID provided by TC TrustCenter. So if you 
have already obtained a TrustCenter Publisher ID (for example from Symbian 
Signed) you can use this ID.  
 
3.3 How do I use the Publisher ID?  

After the successful purchase of the Publisher ID it will appear in the certificate 
store of your Web browser. In order to use the Publisher ID to sign applications, 
you will firstly need to port it to the Wireless Tool Kit or NetBeans. To do this, 
please follow the instructions below, which are based on the following set up: 
 
• Internet Explorer version 6 
• Java Platform Standard Edition 6, keytool.exe application 
• Sun Java Wireless Toolkit 2.5.2 for CLDC 
• NetBeans 

 
The remainder of section 3 will cover the following steps, so if you have already 
done this, then please skip ahead to section 4.   

• Porting the Publisher ID to a .PFX file 
• Copying the Publisher ID to a keystore 
• Using the keystore file with Wireless Tool Kit 
• Using the keystore file with NetBeans 

 
3.3.1 Porting the Publisher ID to a .PFX file 

3.3.1.1 In Microsoft Internet Explorer 

1. Go to the last item in the “Tools” menu, which is called “Internet Options”. In 
“Internet Options” click on the “Content” tab and then select the “Certificates” 
button, which will allow you to view all certificates (see image 1 below).  
 
2. Select the certificate issued by “TC Trustcenter” and press “Export” to start 
porting of the certificate.  
 
3. You will be given a number of options when exporting the certificate from 
the Internet Explorer, so please follow this guidance: 

• Include the private key with the certificate 
• Use Personal Information Exchange format (.PFX) 
• Include all certificates in the certification path  
• No need to select strong protection  
• No need to delete the private key if the export is successful  
• Save the .PFX file to the same directory where the keytool.exe 

application is located. This should make the next steps easier. 
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If you have followed the instructions above, the certificate is now in a .PFX file 
and located in the same directory as the keytool.exe application. 
 

 
Image 1: The Certificates button 
 
3.3.1.2 In Firefox 

1. Go to the last item in the “Tools” menu, which is called “Options”. In 
“Options” click on the “Advanced” selection and then select the 
“Encryption” tab, which will show the “View Certificates” option (see image 
2 below). That opens up a new window which allows you to view all 
certificates.   

2. Select the “Your Certificates” tab and from there select the certificate 
issued by “TC TrustCenter” and press “Backup” to start saving the 
certificate with a selected name to the desired location.  
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Image 2: The View certificates button 
 

3.3.2 Copying the Publisher ID to a keystore 

To copy the Publisher ID from the .PFX file to a specific keystore file, you will 
need to use the key tool application and follow these steps: 
 

1. Open the command prompt and run the keytool.exe application. You will 
need to define a password and remember it, so please write it down 
somewhere safe.  

 
2. Use the following command to copy the Publisher ID to a designated 

keystore file: 
 
Keytool –importkeystore –srckeystore “The_Name_Of_The_PFX_file.PFX” –
destkeystore Name_For_The_Key_store.jks –srcstoretype PKCS12 –
deststoretype JKS 
 
Note: As a shortcut, in some versions of Windows it may be possible to copy / 
paste the text above directly into a command window. 
 
Now the Publisher ID should be in a designated keystore file.  
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You may notice that the Publisher ID has an odd alias. If this is the case, you can 
change this by following these steps:  
 

1. Open the command prompt and locate the keytool.exe and the keystore-file. 
2. Use the following command to define the current alias (note: you will need 

the keystore password that you noted down earlier): 
  keytool -list -keystore Name_Of_The_Key_store.jks 
3. In the case where the keystore has only one item in it, the outcome from the 

keytool command will display the current alias in the first item of the output 
using brackets to distinguish the alias name. 

4. The alias can then be changed with the following command: 
 
keytool -changealias -alias "Enter_The_Alias" -destalias “New_Alias" -keystore 
Name_Of_The_Key_store.jks 
 
3.3.3 Using the keystore file with Wireless Tool Kit 

1. Start Wireless Tool Kit and run the utility called “Sign MIDlet Suite”  
2. Under the “File” menu of “Sign MIDlet Suite” select “Load keystore” and 

then “from file”. This can be used to bring the Publisher ID to the use of the 
“Sign MIDlet Suite”. (Note: The keystore password is required when loading 
the keystore.)  

3. You will be given an option to select the security domain. This is not 
important (as it is not possible to sign applications with Publisher ID and 
install them to a device as the devices do not have the corresponding root 
certificate), so just keep things simple and select “minimum”.  

 
Now the Publisher ID is available for signing the applications.  
 
Note: Appendix A will show a potential script which can be used to sign multiple 
JAD/JAR pairs with Wireless Tool Kit and the Publisher ID. 
 
3.3.4 Using the keystore file with NetBeans 

1. Launch NetBeans. In the “properties” window, select the “Signing” 
category. 

2. Use the keystore manager to add a new keystore from a file (common file 
formats to import are ”.jks, .ks, .keystore, .p12 and .pkcs12”) 

3. After the keystore is imported it must be unlocked. When this is done check 
the “Sign Distribution” box, keystore and alias in the properties -> signing 
menu.  

 
By selecting “Sign Distribution”, the application will be signed at build time using 
the Publisher ID. 
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4. HOW DO I REGISTER TO USE THE SUBMISSION PORTAL? 

As with any new service, you will need to register to use it! Image 3 below shows 
you what you will see when entering the portal for the first time. You will need to 
click on the link “register yourself for an account”. 
 

 
Image 3: The login page of the Submission Portal  
 
Note: We recommend that the person who registers to the Submission Portal is 
the same person who will submit applications to the Portal. Where possible, we 
also recommend that you set up one account for the whole company. To do this 
efficiently you should have one e-mail address that can be accessed by all the 
necessary people. This is because the account you use to submit applications 
will be the same account you use to track the progress of submissions. If there 
are several accounts which submit applications to Java Verified with the same 
Publisher ID, you will be unable to get an overview of all submissions via any one 
account.  
 
The registration page is shown in image 4 below. All fields marked * must be 
completed in order for you to register.  

 

Image 4, the required registration data.  
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The first step is to insert an email address, which will be used both as your login 
name and as the email via which you will receive all communication from the 
Submission Portal. We therefore suggest that you select an email address that is 
accessible to all those who will need to follow the progress of the submission 
process. 

Note: The box requesting your agreement to receive emails from Java Verified is 
to allow us to send you important information about your account and your 
applications. You will not receive spam. 

Once you have completed the registration page, a temporary password will be 
sent to the email address you have specified. You should use this password for 
the first login and will then be prompted to change it. 

 

5. WHAT DO I NEED TO DO BEFORE SUBMITTING AN 
APPLICATION? 

In order to make your experience of the Submission Portal as smooth as 
possible, there are three things to prepare before submitting an application: 
 
• Certain details of how the application meets the testing criteria  
• An application description 
• Grouping JAD and JAR files 

 
5.1 The testing criteria 

The Unified Testing Criteria define certain requirements which must be met 
before submission. Of course, the application must comply with all the test 
criteria, but there are certain details you will be required to provide at the time of 
the submission: 
 
• Application characteristics in Chapter 3.1 of the criteria document:  

o A flow diagram of the application in a JPG or GIF file 
o Definitions of the different connections which the application has 

• A completed questionnaire related to the questions in section 4.9 of the 
criteria document. 

 

5.2 Application description  

Although the application description field can be left empty, if you enter a 
description at the submission stage, this will make it easier to find the submission 
at a later stage. We recommend that you use a description that is shared by the 
different versions of the same application. 
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5.3 Grouping JAD and JAR files 

It is important to consider the option of grouping the application files (JAD and 
JAR files) before submitting application. The Java Verified Submission Portal 
allows a single JAD / JAR pair to be submitted or a ZIP file containing multiple 
JAD / JAR pairs. Therefore all of the JAD / JAR files belonging to the same 
application title can be grouped into one ZIP file and the group can have a unique 
name which is given at the time of the submission. 
 
The grouping of JAD / JAR will make it easier to submit and find different 
versions of the same title. For example if title A has 10 different JAD / JAR pairs 
for multiple devices, grouping them will make submissions easier as the JAD / 
JAR pairs can share the same application flow diagrams and you will only need 
to provide one set of answers to the security questions.  
 
 
6. HOW DO I SUBMIT AN APPLICATION TO THE SUBMISSION 
PORTAL? 

6.1 The submission process 

To submit your application (JAD/JAR pairs), you will need to go to the 
“Submission Home” page and then either click on the “Submit application for 
testing and signing” link in the main text or the “Submit Application” button in the 
left hand menu (see image 5 below). The window shown in image 5 will then 
appear.  

 

Image 5: The Submission home page 
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Image 6: Submitting an application. 

 

In the example in image 6, a zip file full of test data is being uploaded using the 
lower box “Upload ZIP archive with multiple JAD/JAR pairs”. A single JAD / JAR 
pair can also be uploaded via the top box “Upload single JAD/JAR pair”.  

As a ZIP file will contain many different kinds of JAD/JAR pairs, the Portal will 
read the material and see if it is at all acceptable. The page shown in image 7 will 
then display letting you know which files have been successfully uploaded and 
where there are errors. 

This page will also prompt you to enter a “Group name” and “Group description” 
which will help you browse through your different submissions at a later date and 
find this particular one with ease.  
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Image 7: The demo zip file errors and successes. 

 

6.2 Managing your submissions 

Your accepted submissions will then be visible on the Submission Home page as 
shown in image 8. As you can see, the box at the top of this page allows you to 
search for submissions and filter them by “Group” name or “State”. In the lower 
listing, you can sort the information by the application “ID”, “Name”, ”Group”, etc. 
This listing also summarizes key information regarding the status of the 
application such as the “Pretest result”, “Test house result”, etc. 

By clicking on the ID number in the left hand column of the listing, you can view 
the details of a particular submission, as shown in image 9.   
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Image 8: The demo data displayed on the Submission Home page. 

 

Image 9: The details of one submission. 

As you can see, the details of a particular submission are split into five sections: 
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• The “Submission” section gives the overall status of the application, the 
application name and group information, which can be changed. 

• The “Application” section contains the details about the application, which 
application data is complete and which is missing. As discussed above, it 
shows that: 

o Each application must have a diagram file and completed 
questionnaire. 

o Each application must also go through the pretesting procedure, which 
is primarily about which device the application can run on.  

• The “R&D Signature” section allows this to be requested. 

• The “Test” section gives information about how the testing went. A report 
can be downloaded from here. 

• The “Signature” section allows the Java Verified application to be 
downloaded, once it has passed the testing procedures.  

 

7. HOW DO I SUBMIT AN APPLICATION FOR R&D SIGNING? 

R&D Signing is a service that signs applications to the Identified Third Party 
Protection Domain (formerly the Trusted Third Party Domain.) to enable them to 
be run on a device for testing purposes 
 
In order to install the application, the device needs to have the root certificate 
used by Java Verified. Please refer to the “Table of Supported Devices” which 
can be found on the main Java Verified website: www.javaverified.com.  
 
Note: As discussed in section 3, in order to submit an application the application 
has to be signed with the Publisher ID.  
 
To submit an application for R&D signing, please follow these steps: 
 

1. Submit a JAD/JAR pair to the Submission Portal  
2. On the Submission home page, click on the JAD/JAR pair that you would 

like to get R&D Signed. 
3. On the submission details page under the “R&D signature” heading, select 

“Sign application”.  
4. After the application has been signed, it can be downloaded from the 

“Submitted JAD/JAR pair details”-page. This step takes time, so please be 
patient. 

 
Note: When installing the application, the signature in the application is valid on 
the day it was signed and for the preceding six days (central European time 
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zone). This is why the date of the device must be confirmed to ensure it falls 
inside the period when the signature is valid.  
 
To check the dates when the application can be installed:  
 

1. Open the JAD file with a text editor (e.g. notepad) 
 
2. Copy the contents of the “MIDlet-Certificate-1-1:” field (text starting from the 

colon and ending to the carriage return) and paste it to an empty text file. 
 
3. Save the text file 
 
4. Change the file extension to .cer 
 
5. Open the file. The validity is presented in the “Valid from” field (see image 

10 for an example) 
 

 
Image 10: Certificate information showing when the application is valid for 
installation.  
 
Note: The R&D Signing is for testing purposes only. Do not sell a R&D Signed 
application!  
 
 
8. HOW DO I SUBMIT AN APPLICATION FOR TESTING AND 
SIGNING? 

Once your application has been signed with a valid publisher ID and you are sure 
it conforms to the test criteria, you can submit it to a test house for testing.  
 
8.1 Submitting an application for testing 

 
Before you submit an application for testing, please ensure that: 
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• You have submitted the application flow diagram with the application (one 
diagram will suffice for the set of applications in one Submission group). 

• You have completed the “Questionnaire” section of the application data. 
 
To submit an application for testing, follow the steps below: 
 

1. Submit the application to the portal as described above. 
2. On the “Submission home” page, select the JAD/JAR pair which you want 

to have submitted to a test house. 
3. As part of the testing process, an automated pretest will be conducted to 

check which screen size and JSRs the application uses. Based on the 
results of this pretest, the submission tool will indicate which devices the 
application can run on. The next step is therefore to select which device 
will be used to test the application using the "Select devices" option.  

4. Select your test house of choice by choosing "Submit for test" and 
selecting from the list.  

 

8.2 The test results 

When the testing is complete, an email will be sent to notify you that the 
application has been tested and the test report is available. 
 
Log in to the portal and you will find the results on the detail page for the 
application. If the application passed the testing, the signed application will also 
be available to download from this page.  
 

8.3 What do I do if an application failed the testing? 

In the event that an application fails the testing, it must be changed to fix the 
errors and resubmitted. After the issues identified in the test report have been 
addressed, you can resubmit it using the “Update application links on the 
submission details page. Once the application JAD/JAR files have been updated 
and the device for testing is selected, the application can be submitted once 
again for testing to a test house of your choice. 
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9. SEARCHING SUBMISSIONS IN THE PORTAL 

As highlighted in section 6, the Submission Portal offers you multiple methods to 
search your submissions for specific JAD / JAR pairs: 
• By the name of the submission 
• By group names 
• By the status of the application 

 
Furthermore, the resulting list of applications, can be sorted in different ways: 
• ID 
• Name 
• Group 
• Creation date 
• By the status of the : 

o Application data 
o Pretesting result 
o R&D Signature 
o Test house result 
o Production signature 
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ANNEX A: EXAMPLE SCRIPT TO SIGN MULTIPLE JAD / JAR PAIRS 

REM: By: Oscar Vivall 2008 
REM: Script used to sign multiple JAD/JAR pairs 
REM: batch file should be located in the same folder as the applications. 
 
echo off 
cls 
 
set JADTOOLPATH=%1 
set KEYSTORE=%2 
set ALIAS=%3 
set KEYPASS=%4 
 
if NOT DEFINED JADTOOLPATH GOTO INFO 
if NOT DEFINED KEYSTORE GOTO INFO 
if NOT DEFINED ALIAS GOTO INFO 
if NOT DEFINED KEYPASS GOTO INFO 
 
IF NOT EXIST %JADTOOLPATH% ( 
 echo JadTool.jar does not exist 
 echo. 
 GOTO INFO 
) 
 
IF NOT EXIST %KEYSTORE% ( 
 echo Keystore does not exist 
 echo. 
 GOTO INFO 
) 
REM ** Loop though all Jad and jar files in the folder and use the JadTool to sign the 
files ** 
 
for %%a in (*.jad) DO ( 
 echo %%a 
 type %%a | find "MIDlet-Jar-URL:" > tmp.txt 
 for /F "tokens=2" %%i in ('type tmp.txt') DO ( 
  IF NOT EXIST %%i ( 
   echo %%i - ...Does not exist 
   echo :=================: 
  ) 
  if exist %%i ( 
   echo %%i 
    
   java -jar %JADTOOLPATH% -addcert -alias 
%ALIAS% -keystore %KEYSTORE% -inputjad %%a -outputjad %%a 
   java -jar %JADTOOLPATH% -addjarsig -
keypass %KEYPASS% -alias %ALIAS% -keystore %KEYSTORE% -inputjad %%a -
outputjad %%a -jarfile %%i 
 
   echo Done. 
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   echo :=================: 
  ) 
 ) 
) 
 
REM ** END THE LOOP ** 
GOTO END 
:INFO 
echo ------------------------ 
echo By: Oscar Vivall 2008 
echo Script used to sign multiple JAD/JAR pairs located in the same folder. 
echo Use this script from the command prompt. 
echo. 
echo Usage: 
echo signapp.bat [JadTool.jar] [keystore.sks] [alias] [keypassword] 
echo ------------------------ 
:END 
 
IF EXIST tmp.txt DEL tmp.txt 
 
set JADTOOLPATH= 
set KEYSTORE= 
set ALIAS= 
set KEYPASS= 
 
echo. 
PAUSE 
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ANNEX B: FAQ 

Q: What is the difference between signing the application with the Publisher ID, R&D 
Signing and the signing after the application has passed the testing? 
A: Publisher ID signing is used to verify the source of the application. The verification is 
done by the Java Verified Submission Portal. It is needed when submitting the 
application and done by the owner of the application. 
 
The R&D Signing can be used by the developer to test the application. It can be 
achieved by submitting a Publisher ID signed application to the Java Verified 
Submission Portal and requesting R&D Signing for the submitted application. 
 
The third signing is done automatically after the test house has confirmed that the testing 
has been passed. That confirms that the application is Java Verified and is valid for ten 
years. 
 
Publisher ID 
Q: What is a publisher ID? 
A: A Publisher ID is a certificate which validates the existence of a company. Think of it 

as a passport to Java Verified services.  
 

Q: Where can I buy a publisher ID? 
A: TC Trustcenter is the Publisher ID provider. If you are located in China please contact 

GlobalSign China.  
 
Q: How much does it cost? 
A: The annual fee is 200USD. 
 
Q: How long is it valid for? 
A: One year. 
 
Q: Why do I need to sign the applications I submit with a Publisher ID? 
A: This allows Java Verified to confirm the source of the application and that the 

applications have not been tampered with. 
 
Q: I signed my application with a Publisher ID, so why does it not install to my device? 
A: The MIDP2 specification prevents installation of applications, which are signed but 

where the signature cannot be verified such as in the case of Publisher IDs. For an 
application to install on a device, it must be signed with a certificate with a signature 
that can be verified with a certificate that resides in the device. Since Publisher IDs do 
not have a certificate in the devices, the application installation will not work.  

 
Q: Do I also need to sign MIDP1 applications with a Publisher ID? 
A: Yes. The source and integrity of every application is checked during submission.  
 
Q: My Publisher ID is already in a .p12 file. What do I need to do? 
A: A .p12 file can be used with the keytool application. 
 
Q: Can I use my TC Trustcenter Publisher ID, which I purchased for Java Verified with 

Symbian Signed? 
A: Under normal circumstances, yes. However the Symbian signing tool (SignSIS) has 

not been updated, and therefore only currently accepts Symbian Publisher IDs. 
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Q: I have a Publisher ID from TC TrustCenter which I use with Symbian Signed. Can I 

use that with Java Verified? 
A: Yes as long as it is still valid. 
 
Java Verified Submissions Portal 
Q: What is the Java Verified Submissions Portal? 
A: It is a portal for submitting applications and managing submissions to different Java 

Verified services. 
 
Q: What is a group? 
A: A group is a common name to a group of JAD/JAR pairs. 

 
Q: When I submit an application I get an error message: "Application is not signed with a 

valid Publisher ID certificate. Please sign the application with your Publisher ID!” 
What is wrong? 

A: It can mean one of three things: (i) Something went wrong when the application was 
signed with the Publisher ID. We therefore recommend you re-sign the application; (ii) 
the Publisher ID is not valid for Java Verified; please purchase a valid Publisher ID; 
(iii) The Publisher ID is no longer valid. 

 
Q: When I submit an application I get an error message: "Unable to parse the JAD file 

[Name_of_the_JAR.jar] provided for upload!” What is wrong? 
A: Please check that you have defined a proper JAD file.  
 
Q: When I submit an application I get an error message: "No certificate found in JAD file. 

Please sign the application with your Publisher ID!". What is wrong? 
A: The application has not been signed with a Publisher ID. Please sign the application 

with a valid Publisher ID. 
 
 

R&D Signature 
Q: What is R&D Signature intended for? 
A: The intention is to provide a way for developers to test how the application behaves 

on a live device after it has been signed. The signature is for testing purposes only, 
not for commercial applications.  

 
Q: Why is the R&D Signature valid only for 7 days? 
A: The intention is to ensure that R&D signed applications are not sold or distributed 

further.  
 
Q: Why cannot I install an R&D Signed application to a live device? 
A: There are two reasons why the installation fails: (i) The signature in the application is 

not valid. Please confirm that the date and the time of the device are in the range 
when the application signature is valid; (ii) Please confirm that the device has the UTI 
root certificate in it. The list of supported devices on www.javaverified.com gives this 
information.  

 
Q: How do I know when the R&D Signature is valid? 
A: Please use the following steps:  

1. Open the JAD file with a text editor 
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2. Copy the contents of the “MIDlet-Certificate-1-1:” field (text starting from the colon 
and ending to the carriage return / line feed) and paste it to an empty text file. 

3. Save the text file 
4. Change the file extension to .cer 
5. Open the file, the validity is presented in the “Valid from” field. 

 
Q: Will my R&D Signed application stop from running when the certificate validity period 

is over? 
A: No. The date is validated only at the installation of the application. 


